Before your pharmacy can begin using automated dispensing devices, the Automated Dispensing Interface (ADI) software must be installed and configured at your pharmacy.

The following automated dispensing devices are integrated with PharmaClik Rx:

- AutoMed ATC FastPak (non-retail packaging)
- AutoMed ATC Profile (non-retail packaging)
- AutoMed FastFill (retail prescriptions)
- Baker Cell (retail prescriptions)
- MEDS PacMed (non-retail packaging)
- Parata RDS (retail vial-filling robot)

Questions or concerns regarding automated dispensing integration should be directed to Pharmacy Technology Solutions at 1-800-387-6093.
# Table of Contents

1. **Starting Up** ......................................................................................................................................................... 1

2. **Configuring Drugs for Auto-Dispensing** ........................................................................................................... 2

3. **Configuring Groups for Auto-Dispensing** ......................................................................................................... 3
   - Group Auto-Dispensing Preferences .......................................................................................................................... 3
   - Patient-Level Override .................................................................................................................................................. 4

4. **Filling Prescriptions** .............................................................................................................................................. 5
   - Retail Prescriptions .......................................................................................................................................................... 5
   - Non-Retail Prescriptions .................................................................................................................................................. 5
   - Entering Dosages for Non-Retail Prescriptions ........................................................................................................... 6
   - Prescriptions with Standard Administration Times ....................................................................................................... 7
   - Prescriptions Administered on Specific Days .................................................................................................................. 7
   - Prescriptions with Alternate Days Dosing ...................................................................................................................... 8
   - PRN Prescriptions ............................................................................................................................................................ 8
   - Prescriptions with Increasing/Decreasing Dosages ...................................................................................................... 9
   - Overriding Automated Dispensing in Rx Detail ............................................................................................................. 10
   - Pharmacy Preference: Reset Auto-Dispensing on Refill .............................................................................................. 10
   - Auto-Dispensing Indicator on the Profile .................................................................................................................... 11

5. **Processing Prescriptions in ADI** .......................................................................................................................... 12
   - Processing Non-Retail Prescriptions from To Do ................................................................................................. 12
   - Editing & Reviewing Non-Retail Prescriptions ............................................................................................................ 13
   - Process Group Rx: Viewing Details for a Non-Retail Prescription ............................................................................. 14
   - Reviewing Prescriptions with Standard Administration Times ..................................................................................... 15
     - To confirm and edit dosages ........................................................................................................................................ 15
   - Prescriptions with Increasing/Decreasing Dosage ...................................................................................................... 16
     - To edit prescriptions with variable dosages ................................................................................................................ 16
   - PRN Prescriptions .......................................................................................................................................................... 17
     - To edit PRN prescriptions .......................................................................................................................................... 17
   - Narcotic Prescriptions ..................................................................................................................................................... 17
   - Resetting Default Packaging Options ........................................................................................................................ 18
   - Submitting Ready Transactions to the Device ............................................................................................................. 19
     - To preview the transactions before sending them to the device ................................................................................ 19
     - To submit Ready transactions without previewing .................................................................................................. 19
   - Viewing Completed Transactions ............................................................................................................................... 20

6. **Error Messages** ...................................................................................................................................................... 21
   - Viewing Messages ............................................................................................................................................................. 21
   - Deleting Messages ............................................................................................................................................................ 22
   - Viewing Messages for all Workstations ........................................................................................................................ 22
     - To view all messages ..................................................................................................................................................... 22
     - To view message for your workstation ......................................................................................................................... 22

7. **Regenerating Prescriptions** ............................................................................................................................... 23
   - To regenerate prescriptions .......................................................................................................................................... 23

8. **Customizing Views in ADI** ................................................................................................................................... 24
   - Customizing Columns ................................................................................................................................................... 24
   - Resizing Columns ............................................................................................................................................................ 24
1. Starting Up

Once the Automated Dispensing Interface (ADI) software has been installed in your pharmacy, an ADI icon will be located on your desktop. **ADI is required for PharmaClik Rx to interact with automated dispensing devices.** When starting the PharmaClik Rx applications each morning, ensure ADI is started on the Workstation from which you will be processing auto-dispensed prescriptions.
2. Configuring Drugs for Auto-Dispensing

To use automated dispensing, the Auto Disp field must be set in the Drug folder for the appropriate drugs. Once automated dispensing is set for a drug, prescriptions for that drug will be dispensed from the selected device. If a drug will be auto-dispensed from both retail and non-retail devices, set the drug up for the RETAIL device, ensuring it will be auto-dispensed for all retail prescriptions; the non-retail device can be configured at Group level, overriding the drug’s setting at the time of fill.

The available options in the Auto Disp field are:
- **No auto-dispensing**: The drug will not be dispensed by an automated dispensing device. This is the default setting for all drugs.
- **All automated dispensing devices configured for your pharmacy are shown in the dropdown list. To dispense from a specific device, select the name of the device from the dropdown list.**

### To set automated dispensing for a drug

1. Press or click the Drug button.
2. Search for and select the drug that will be auto-dispensed.
3. Press or click the DIN tab in the Drug folder, if it is not already displayed on the screen.
4. Select the appropriate device from the Auto Disp dropdown list.
5. Press or click the Save button.

**An Important Note Regarding Negative DINs**

Some automated dispensing devices can accommodate prescriptions filled for negative DINs. This can be done if the device’s software has a secondary or auxiliary DIN field for each DIN. The secondary DIN field can contain the PharmaClik Rx negative DIN and the main DIN field can use the DIN required by the device’s software. Please confirm with your device provider before filling prescriptions for negative DINs.
3. Configuring Groups for Auto-Dispensing

The Auto-dispensing preferences in the Groups folder dictate whether or not a patient's prescriptions will be dispensed from an automated dispensing device. The group preference allows a default device to be selected for the entire group, while a setting at patient level overrides the group preference. The Rx Detail provides a final override when determining if a prescription should be auto-dispensed. For further details, refer to the Overriding Automated Dispensing in Rx Detail section).

Group Auto-Dispensing Preferences

Allow Auto-Dispensing

Determines if prescriptions for the Group's patients will be auto-dispensed. When a device is selected, the group's prescriptions will be auto-dispensed from that device. When No auto-dispensing is selected, no prescriptions will be auto-dispensed for this group.

Prescription Type

Allows you to exclude Narcotics and PRNs from auto-dispensing. By default, Narcotics and PRNs are included.

DispillDosett: Dispill and Dosett prescriptions are NEVER auto-dispensed. Disregard these preferences, as they will be removed in a future version of the PharmaClik Rx.

Narcotics: When selected, prescriptions for narcotic drugs are submitted to ADI, and are printed at the end of the run, after any PRN prescriptions. When the flag is OFF, Narcotics prescriptions are set to No auto-dispensing in Rx Detail.

PRNs: When selected, prescriptions using PRN as the administration time are submitted to ADI; they are packaged at the end of the run, before Narcotics. When the flag is OFF, PRN prescriptions are set to No auto-dispensing in the Rx Detail.
To set a group’s auto-dispensing preferences

1. Press or click the More button.
2. Press or click the Groups.
3. Search for and select the group.
4. Press or click the Preferences tab.
5. Press or click the Auto-Dispensing button. The Group Auto-Dispensing Preferences window opens.
6. Make a selection from the Allow Auto-Dispensing dropdown list.
   a. To disable automated dispensing: Select No auto-dispensing.
   b. To enable automated dispensing: Select an automated dispensing device to use for patients in this group, or select Default to use the drug’s automated dispensing device.
7. Under the Prescription Type, choose the types of prescriptions to include when auto-dispensing: Narcotics, PRNs. Turn a checkbox ON to include a prescription type or OFF to exclude a type.
8. Press or click the OK button.

Patient-Level Override

The Allow Auto-Disp column in the Group folder Patients tab provides a patient-level override for the Allow Auto-Dispensing group preference. It determines if a specific patient’s prescriptions will be auto-dispensed; the dropdown list contains all devices configured for the pharmacy, along with Default and No auto-dispensing options. The Default uses the group preference to determine if prescriptions can be auto-dispensed; choosing a specific device allows automated dispensing for the patient, while the No auto-dispensing disables auto-dispensing for the patient.

Patient-Level Override Table

<table>
<thead>
<tr>
<th>Name</th>
<th>Allow Auto Disp</th>
<th>Floor</th>
<th>Wing</th>
<th>Area</th>
<th>Room</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acheson, Richard</td>
<td>Default</td>
<td>3</td>
<td>EAST</td>
<td>302</td>
<td>302</td>
</tr>
<tr>
<td>Arnold, Chris</td>
<td>Default</td>
<td>2</td>
<td>EAST</td>
<td>201</td>
<td>201</td>
</tr>
<tr>
<td>Barrett, Hank</td>
<td>Default</td>
<td>2</td>
<td>EAST</td>
<td>202</td>
<td>202</td>
</tr>
<tr>
<td>Bell, Monica</td>
<td>Default</td>
<td>2</td>
<td>WEST</td>
<td>211</td>
<td>211</td>
</tr>
<tr>
<td>Black, Jonathan</td>
<td>Default</td>
<td>2</td>
<td>WEST</td>
<td>212</td>
<td>212</td>
</tr>
<tr>
<td>Campbell, Wendy</td>
<td>Default</td>
<td>2</td>
<td>WEST</td>
<td>213</td>
<td>213</td>
</tr>
<tr>
<td>Carson, Emily</td>
<td>Default</td>
<td>3</td>
<td>WEST</td>
<td>312</td>
<td>312</td>
</tr>
<tr>
<td>Carson, Elizabeth</td>
<td>No auto-dispensing</td>
<td>3</td>
<td>WEST</td>
<td>312</td>
<td>312</td>
</tr>
<tr>
<td>Denison, Harvey</td>
<td>Default</td>
<td>1</td>
<td>WEST</td>
<td>314</td>
<td>314</td>
</tr>
<tr>
<td>Garrison, Allon</td>
<td>Default</td>
<td>1</td>
<td>WEST</td>
<td>301</td>
<td>301</td>
</tr>
<tr>
<td>Harris, Roland</td>
<td>Default</td>
<td>1</td>
<td>EAST</td>
<td>303</td>
<td>303</td>
</tr>
<tr>
<td>Johnson, Joe</td>
<td>Baker Cells</td>
<td>3</td>
<td>WEST</td>
<td>316</td>
<td>316</td>
</tr>
<tr>
<td>Kennedy, April</td>
<td>Default</td>
<td>2</td>
<td>EAST</td>
<td>205</td>
<td>205</td>
</tr>
<tr>
<td>Lewis, Irene</td>
<td>Default</td>
<td>2</td>
<td>EAST</td>
<td>206</td>
<td>206</td>
</tr>
<tr>
<td>Mandock, Alyssa</td>
<td>Default</td>
<td>3</td>
<td>EAST</td>
<td>305</td>
<td>305</td>
</tr>
<tr>
<td>Sanderson, Marion</td>
<td>Default</td>
<td>3</td>
<td>EAST</td>
<td>316</td>
<td>316</td>
</tr>
<tr>
<td>Traverse, Jess</td>
<td>Default</td>
<td>3</td>
<td>WEST</td>
<td>316</td>
<td>316</td>
</tr>
</tbody>
</table>

To set a patient’s automated dispensing preference

1. Open the Group’s folder.
2. Press or click the Patients tab.
3. Highlight the patient. Scroll to the right until the Allow Auto Disp column is displayed.
   ▪ To disable automated dispensing: Select No auto-dispensing.
   ▪ To enable automated dispensing: Select an automated dispensing device to use a specific device for this patient, or select the Default to use the group’s automated dispensing device.
4. Press or click the Save or the OK button.
4. Filling Prescriptions

Once automated dispensing is set for a drug, prescriptions for the drug will be dispensed from the appropriate device. The prescription-level setting for automated dispensing is taken from the drug setting for retail prescriptions. Non-retail prescriptions use the following hierarchy: drug, group and then patient.

Retail Prescriptions

Verify the information and fill the prescription as usual. The medication is dispensed from the retail device selected in the Drug folder.

NOTE: Patients in retail groups do not use Administration Times; therefore their prescriptions cannot be dispensed from dose packaging machines such as AutoMed’s ATC FastPak or ATC Profile.

Non-Retail Prescriptions

The Non-retail prescriptions are filled for patients in the non-retail groups such as nursing homes, correctional facilities, or any other type of long-term care facility.

NON-RETAIL PRESCRIPTIONS WITH NO ADMIN TIMES WILL NOT BE AUTO-DISPENSED.

The Admin Times entered for the Non-Retail prescriptions must following these rules:

- The times must be in a 24-hour format and include a colon.
- Multiple times are separated by a comma with no spaces.
- Midnight must be entered as 00:00, not 24:00.
- The only allowable alpha administration time is PRN.

Example. Administration times of 9:30am, 1:30pm and midnight would be entered as: 09:30, 13:30, and 00:00

Dosage quantities must be entered in Administration Details for each administration time – refer to the next page for details.
Entering Dosages for Non-Retail Prescriptions

When filling the Non-Retail Prescriptions, the quantity of medication per dosage time should be entered in the Administration Details window located in the Rx Detail. Entering the information in this window ensures the data is retained and applied to all future refills – values entered in this window are passed to ADI for packaging purposes.

The device from which the prescription will be dispensed is indicated in the Allow Auto-Dispensing field. This is determined by the drug, group and patient settings for the Allow Auto-Dispensing, with the prescription level being the final override.

For the non-retail prescriptions, Dosage quantities must be entered for each administration time. These values are passed to ADI. The Default dosages correspond to the admin times in the Rx Detail tab; changes to the Default update the admin times displayed in the main tab and vice versa. The Insert Time and the Delete Time buttons allow times to be added and removed.

The Start Date is the date the patient first began taking the medication – THIS IS NOT THE PACKAGING START DATE. This date does not reset on refill, as the Alternate Days dosing (in the Days Options) is calculated from the Start Date, for the life of the medication. The Start Date is automatically set to the Fill Date when a NEW prescription is filled (i.e. the first prescription in the Audit History). The Start Date must be modified if a prescription’s alternate days dosing is changed.

The Days Options allow you to choose alternate days or specific days dosing for a prescription. The Alternate Days are calculated from prescription’s the Start Date, ensuring consistency throughout the life of the prescription. The corresponding days are highlighted on the calendar for the prescription’s days’ supply. The Specific Days options allow you to indicate specific days of the week on which the medication should be provided to the patient; if you would like the medication to be provided to the patient on a specific day of the week, select the checkbox corresponding to that day. Multiple days of the week can be selected. When no Days Options are selected, medication is provided every day. 

To open Rx Detail – Administration Details for a non-retail prescription, press the magnifying glass icon located the Group box in the main tab of Rx Detail. For retail prescriptions, the button is located in the upper right corner of the label preview.
Prescriptions with Standard Administration Times

The prescriptions with standard administration times have the same dosage times and quantities each day throughout the life of the prescription.

1. Open the prescription in the Rx Detail as usual.
2. Enter or modify the basic prescription information (QA, Qty, SIG, DS, etc...). Enter the Admin Times and the Rx Status. Refer to the Non-Retail Prescription section for rules regarding administration times.
3. The Administration Details window opens. Verify the device in the Allow Auto-DISPensing field.
4. In the Dosages box, enter the Qty to be dispensed at each administration time. Partial quantities must be entered in decimal format.

Use the following decimals for partial quantities:

1/8 = .125 (may not be supported by all devices)
1/4 = .25
1/3 = .3
1/2 = .5
2/3 = .6
3/4 = .75 (may not be supported by all devices)

NOTE Some automated dispensing devices do not support all types of partial quantities – confirm supported partial quantities with your device provider.

5. Press or click the OK button.
6. Continue to fill the prescription as usual. If any changes are made to the administration times in the Rx Detail tab, repeat steps 3-5.

Prescriptions Administered on Specific Days

Prescriptions can be administered on specific days of the week, rather than on consecutive days.

1. Open the prescription in the Rx Detail as usual.
2. Enter or modify the basic prescription information (QA, Qty, SIG, DS, etc...). Enter the Admin Times and the Rx Status. Refer to the Non-Retail Prescription section for rules regarding admin times.
3. Press the magnifying glass icon located in the Group box in the main tab of Rx Detail.
4. The Administration Details window opens. Verify the device in the Allow Auto-DISPensing field.
5. In the Dosages box, enter the Qty to be dispensed at each administration time. Partial quantities must be entered in decimal format.
6. On the right side of the window, choose the Specific Days of the week on which the medication will be administered. One or more days can be selected. The selected days of the week are highlighted on the calendar.

7. Press or click the OK button.
8. Continue to fill the prescription as usual.

TIP If the changes are made to the administration times in the main tab of the Rx Detail, dosage quantities are reset, return to the Administration Details to re-enter the dosage quantities for each administration time.
Prescriptions with Alternate Days Dosing

Prescriptions can be selected for alternate days dosing when the medication is administered every other day.

1. Open the prescription in the Rx Detail as usual.
2. Enter or modify the basic prescription information (QA, Qty, SIG, DS, etc…). Enter the Admin Times and the Rx Status. Refer to the Non-Retail Prescription section for rules regarding admin times.
3. Press or click the magnifying glass icon located in the Group box in the main tab of Rx Detail.
4. The Administration Details window opens. Verify the device in the Allow Auto-Dispensing field.
5. In the Dosages box, enter the Qty to be dispensed at each administration time. Partial quantities must be entered in decimal format.
6. Enter or update the prescription’s Start Date – this is the date the patient will be taking the medication (or in the case of a refill, the date the patient began taking the medication).
7. On the right side of the window, choose the Alternate Days. Every other day is highlighted on the calendar, beginning from the Start Date if this is a new prescription.
8. Press or click the OK button.
9. Continue to fill the prescription as usual.

TIP This date does not reset on refill, as the Alternate Days dosing is calculated from the Start Date, for the life of the medication. This ensures the appropriate alternate days dosing is consistently applied to refills.

PRN Prescriptions

The PRN prescriptions have PRN as the administration time in the Rx Detail. These prescriptions are filled in the same manner as a prescription with standard administration times. The PRN is the only allowable alpha administration time for automated dispensing.

1. Open the prescription in the Rx Detail as usual.
2. Enter or modify the basic prescription information (QA, Qty, SIG, DS, etc…). Enter the Admin Times and the Rx Status. Refer to the Non-Retail Prescription section for rules regarding admin times.
3. Press the magnifying glass icon located in the Group box in the main tab of the Rx Detail.
4. The Administration Details window opens. Verify the device in the Allow Auto-Dispensing field.
5. In the Dosages box, enter the PRN Qty to be dispensed. Partial quantities must be entered in decimal format.

TIP If changes are made to the administration times in the main tab of the Rx Detail, dosage quantities are reset; return to the Administration Details to re-enter the dosage quantities for each administration time.
6. If the **Days Options** apply to the prescription, select the appropriate **Alternate Days** or **Specific Days**. Verify the **Start Date if Alternate Days** is selected.

7. Press or click the **OK** button.

8. Continue to fill the prescription as usual.

**TIP** If changes are made to the administration times in the main tab of the **Rx Detail**, dosage quantities are reset; return to the **Administration Details** to re-enter the dosage quantities for each administration time.

---

**Prescriptions with Increasing/Decreasing Dosages**

The **Dosage by Days** allows you to enter varying dosages based on day or administration time. This is useful for medications such as Prednisone and Domperidone. The varying administration times and dosages are passed to ADI for packaging, and the prescription uses the default administration time in the main tab of the **Rx Detail** for **MARs**.

1. Open the prescription in the **Rx Detail** as usual.

2. Enter or modify the basic prescription information (QA, Qty, SIG, DS, etc…). Enter the **Admin Times** and the **Rx Status**. Refer to the **Non-Retail Prescription** section for rules regarding admin times.

3. Press or click the magnifying glass icon located in the **Group** box in the main tab of the **Rx Detail**.

4. The **Administration Details** window opens. Verify the device in the **Allow Auto-Dispensing** field.

5. If the **Days Options** apply to the prescription, select the appropriate **Alternate Days** or **Specific Days**, or select/deselect days on the **Calendar**. Verify the **Start Date if Alternate Days** is selected.

**TIP** When using the **Calendar** to select days, use the **Clear Days** button to remove all highlighted days from the calendar, or use the **Default Days** button to reset the calendar to match the originally selected days for the prescription’s days’ supply.

6. Press or click the expand icon located in the **Dosages** box. The **Dosage by Days** window opens, displaying all dates and administration times in the prescription’s days’ supply.

**TIP** Use the **Insert Time** and the **Delete Time** buttons in the **Dosage by Days** to add and remove times.

7. In the **Dosage by Days**, enter the appropriate **Qty** for each date/time combination. If you do not wish to delete a time, but no medication will be provided, enter **0**.

8. Press or click the **OK** button to save dosages.
9. The screen returns to the Administration Details. No quantities are displayed for the Default dosages. The selected dates can be viewed from the Dosages dropdown list; the dosage quantities are displayed for a selected date.

10. Press or click the OK button.
11. Continue to fill the prescription as usual.

TIP If changes are made to the administration times in the main tab of the Rx Detail, dosage quantities are reset; return to the Administration Details to re-enter the dosage quantities for each administration time.

Overriding Automated Dispensing in Rx Detail

When a drug is set for auto-dispensing, the Allow Auto-Dispensing field in the Administration Details is populated with the name of a device, indicating the medication will be dispensed from that device. If you do not want the medication to be auto-dispensed, choose the No auto-dispensing. This must be done BEFORE the prescription is filled.

The setting in the Allow Auto-Dispensing is retained for refills unless the Reset Auto-Dispensing on Refill is ON (see below for more information).

To override automated dispensing in Rx Detail

1. The incomplete prescription should be open in the Rx Detail.
2. Press or click the magnifying glass icon located near the middle of the window.
3. The Administration Details window opens. Make a selection from the Allow Auto-Dispensing dropdown list.

TIP Only configured retail devices are listed for retail prescriptions. All configured devices are listed for non-retail prescriptions.

4. Press or click the OK button.
5. Continue to fill the prescription as usual.

Pharmacy Preference: Reset Auto-Dispensing on Refill

The pharmacy preference Reset Auto-Dispensing on Refill automatically resets the prescription’s Allow Auto-Dispensing field when a prescription is refilled. It is recommended that this flag be ON, ensuring all prescriptions are reset to the appropriate device according to the drug, group and patient hierarchy.

To set the pharmacy preference

1. Press or click the More button.
2. Press or click the Pharmacy button.
3. Press or click the Rx Detail tab.
4. Select the Reset Auto-Dispensing on Refill (located on the left side of the window).
5. Press or click the Save button.
Auto-Dispensing Indicator on the Profile

The **Auto** flag in the patient's profile indicates if the prescription was filled through automated dispensing. To view the **Auto** flag, deselect the **Condense** flag in the patient's profile.
5. Processing Prescriptions in ADI

Once the prescription is Complete in PharmaClik Rx the information is passed to the automated dispensing device via the Automated Dispensing Interface (ADI). ADI is divided into five views: To Do, Pending, Processed, Messages and Devices. Prescriptions are processed from the To Do and Pending views. Any processing errors are shown in the Messages view.

To see the various views, press the icon corresponding to the view (e.g. press the To Do icon to see prescriptions in the To Do view).

Prescriptions for retail devices are submitted to the device without additional intervention and automatically move to the Processed.

The prescriptions with administration times are located in the To Do view. Additional intervention is required for these prescriptions; they cannot be processed until you move them to the Pending view and review/edit the information required to package the prescriptions. The following pages explain how to process and edit non-retail prescriptions from ADI.

Processing Non-Retail Prescriptions from To Do

As described above, prescriptions in the To Do view must be processed by manually moving them to the Pending tab. You can process the prescriptions individually, or multiple at a time.

1. Press or click the To Do icon in the Views menu located on the left side of the window.
2. To process a single prescription: Highlight the prescription.
   To process multiple selected prescriptions: Highlight each prescription that you want to process.
   • To highlight multiple prescriptions, hold down the CTRL key on the keyboard while highlighting.
   • To highlight a list of consecutive prescriptions, highlight the first prescription in the list, then hold down the ‘Shift’ key on the keyboard while highlighting the last prescription in the list – all rows between the first and last prescriptions become highlighted.

   To process a group of prescriptions: Prescriptions can be grouped in a view – refer to the Grouping and Sorting Rows for details. To highlight all prescriptions in a group, press or click on the title bar for the group.

   To process all prescriptions in To Do: Press CTRL + A on the keyboard, OR press or click the Edit in the menu bar at the top of the window, then press or click the Select All. All prescriptions in the To Do become highlighted.
3. Press or click the File in the menu bar at the top of the window.
4. Press or click the Set To Do Transactions to Pending.
5. The **Send To Do Transactions to Pending** window appears. The default packaging options must be set for the selected prescription(s). Enter the **Default Start Date**. The remaining fields are optional – enter values in the **Default End Date**, **Default Start Time** and/or the **Default End Time** if needed.

6. Press or click the **OK** button.

7. A prompt indicates the selected prescriptions have been sent to the Pending or Ready. Press or click the **OK** in the message. All of the transactions will be listed in the **Pending** view.

**Editing & Reviewing Non-Retail Prescriptions**

Once prescriptions are listed in the **Pending** view with a status of **Pending**, additional intervention is required. A prescription has a **Pending** status if it meets one of the following criteria:

- It is the first time the prescription has ever been auto-dispensed from the ADI interface.
- The prescription has no dosages.
- The prescription dosage has been modified since the last fill.

To access the **Pending** view, press or click the **Pending** icon in the menu bar on the left side of the window.

**Pending** prescriptions are displayed in red; these transactions must be reviewed before further processing can occur. **Ready** and **Ready** prescriptions can be sent for packaging.

Pressing the ENTER key on the keyboard opens the **Process Group Rx** window for the highlighted prescription(s). When multiple prescriptions are highlighted, each prescription is detailed consecutively.
Process Group Rx: Viewing Details for a Non-Retail Prescription

The **Process Group Rx** window appears for non-retail prescriptions. The prescription's packaging details are set in this window. If dosages were entered in the **PharmaClik Rx**, they will be populated in the **Process Group Rx** window.

**General information** about the prescription is shown at the top of the window: Rx#, patient name and group name are shown in the title bar; DIN and the drug name, as set in Rx Detail; SIG and translated instructions. To see more of the SIG or instructions, place your cursor in the field and use the ← or → arrow keys on the keyboard to move the view to the left or right. Four lines of translated instructions can be displayed at once; a vertical scrollbar appears if the instructions are longer than four lines. When additional instructions exist, they are prefixed with ‘Additional Instructions:’ in red text.

**Rx Quantity Dispensed** shows the quantity in the prescription. **Total Quantity** is calculated using the quantity for each dosage time (listed on the left side of the window). The **Warning** below Total Quantity is displayed until the **Total Quantity** matches the Rx Quantity Dispensed.

**Calculation:**

\[
\text{Total Quantity} = \text{Quantity per Day} \times \text{Days Selected}
\]

The **OK** button is disabled until quantities are entered for each dosage time.

If dosage quantities were not entered in **Rx Detail** at the time of filling, the **Qty** must be entered here. Insert **Time** and Delete **Time** allow dosages to be added/removed.

Delete **Rx** deletes the prescription from the ADI; the prescription will not be packaged.

Refresh updates the prescription in ADI, if it has been modified in the **PharmaClik Rx** (e.g., if the prescription has been amended or rebilled).

The **device from which the prescription will be packaged**.

The prescription will be packaged from the **Packaging Start Date**. The **Packaging End Date** can be entered if you are only packaging a reduced days' supply, instead of the prescription's entire days' supply. The **Packaging Start Time** and the **Packaging End Time** allow you to specify the first and last dosage for a strip (no times are specified when the time is 00:00).

**Delete Rx** deletes the prescription from the ADI; the prescription will not be packaged.

Refresh updates the prescription in ADI, if it has been modified in the **PharmaClik Rx** (e.g., if the prescription has been amended or rebilled).

**Calendar TIPS**

- Packaging dates are highlighted in blue; no medication is provided on dates that are not highlighted during the packaging period.
- Press or click the **Next** button at the top of the calendar to view dates for the next month. Press or click the **Previous** to view display dates for the previous month. Press or click the **Current** to return to the current month.
- Any dates you have chosen will be retained, even if you view a different month.
- To clear all selected dates and start over, press or click the **Clear Days** button.
- To select the days corresponding to the days' supply in the prescription, press or click the **Default Days** button. When pressed, the selected days will start at the date defined in the **Packaging Start Date** field and continue until all of days in the days supply are selected (e.g., if the Start Date is Sep 25, 2007 and the days' supply is 7, then September 25 to October 1 would be highlighted.)
Reviewing Prescriptions with Standard Administration Times

It is necessary to review all Pending prescriptions before they can be processed. Once a Pending prescription has been reviewed, its status changes to Ready.

To confirm and edit dosages

1. Press or click the Pending icon in the Views menu located on the left side of the window.
2. To review a single prescription: Highlight the Pending prescription.

**TIP** Save steps by double-clicking on the prescription. This immediately opens the Process Group Rx window. Skip to step 5 below.

To review multiple selected prescriptions: Highlight each prescription that you want to process.

- To highlight multiple prescriptions, hold down the CTRL key on the keyboard while highlighting.
- To highlight a list of consecutive prescriptions, highlight the first prescription in the list, then hold down the SHIFT key on the keyboard while highlighting the last prescription in the list – all rows between the first and last prescriptions become highlighted.

To review a group of prescriptions: Prescriptions can be grouped in a view – refer to the Grouping and Sorting Rows for details. To highlight all prescriptions in a group, click on the title bar for the group.

To review all prescriptions in Pending: Press CTRL + A on the keyboard, OR press the Edit in the menu bar at the top of the window, then press or click the Select All. All prescriptions in Pending become highlighted.

3. Press or click the Edit in the menu bar at the top of the window.
4. Press or click the Edit Transaction(s).

**TIP** Save a step by pressing the ENTER key on the keyboard or the ✔ button in the menu bar instead of accessing Edit → Edit Transaction(s).

5. The Process Group Rx window opens. Verify the Packaging Start Date to ensure the correct date has been set; make any necessary changes.

**TIP** If multiple prescriptions have an incorrect date, the Packaging Start Date can be reset for all selected prescriptions – refer to the Resetting Default Packaging Options for details.

6. Verify the administration dates in the Calendar located in the middle of the window; make any necessary changes.
7. In the Dosages box, verify the Qty to be dispensed at each administration time; make any necessary changes. Partial quantities must be entered in decimal format.

Use the following decimals for partial quantities:
- $1/8 = .125$ (may not be supported by all devices)
- $1/4 = .25$
- $1/3 = .3$
- $1/2 = .5$
- $2/3 = .6$
- $3/4 = .75$ (may not be supported by all devices)

**NOTE** Some automated dispensing devices do not support all types of partial quantities – confirm supported partial quantities with your device provider.

8. The fields on the right side of the calendar indicate the amount of medication being dispensed according to the information in the calendar and dosage fields. The Total Quantity is valid once it matches the Rx Qty Dispensed.

9. Press or click the OK button to save and apply the changes. The status of the prescription changes from the Pending to Ready.
Prescriptions with Increasing/Decreasing Dosage

The **Dosage by Days** option allows you to enter varying doses based on a day or administration time. This is useful for medications such as Prednisone and Domperidone.

**To edit prescriptions with variable dosages**

1. Follow steps 1 – 5 from **To confirm and edit dosages** on the previous page.
2. Using the **Calendar**, highlight the days on which the patient will take the medication. These dates will appear in the **Date** dropdown list.
3. Press or click the expand button located beside the **Date**. The **Dosage by Days** window opens.
4. In the **Dosage by Days**, enter the appropriate the **Qty** for each date\time combination. Insert and delete times as required. If you do not wish to delete a time, but no medication will be provided, enter 0.
5. Press or click the **OK** button to return to the **Process Group Rx** window.
6. The fields on the right side of the calendar indicate the amount of medication being dispensed according to the information in the **Calendar** and **Dosage** fields. The **Total Quantity** is valid once it matches the **Rx Qty Dispensed**.
7. Press or click the **OK** button to save and apply the changes. The status of the prescription changes from **Pending** to **Ready**.

If you wish to abort all changes, press the **Cancel** button. You can return to the prescription at a later time to update the information. The prescription status remains Pending.

---

**TIP** Use the **Insert Time** and the **Delete Time** buttons in the **Dosage by Days** to add and remove times.
PRN Prescriptions

The PRN prescriptions appear in the Process Group Rx window with the administration times disabled. These prescriptions will be dispensed at the end of the packaging run, before any Narcotic prescriptions.

The indicator PRN appears beside the drug information.

The PRN administration time cannot be modified. Ensure the appropriate quantity is entered.

TIP If PRN prescriptions are not being sent to ADI, verify the group’s Auto-Dispensing Preferences. The PRN must be selected in the Prescription Type box. Refer to pages 4-5 for details.

To edit PRN prescriptions

1. Follow steps 1 – 5 in the To confirm and edit dosages section.
2. Verify the administration dates in the calendar; make any necessary changes.
3. In the Dosages box, verify the Qty to be provided in each POUCH; make any necessary changes (e.g. If the patient is to take 2 tablets when needed, the amount per package should be 2).
4. Press or click the OK button to save and apply the changes. The status of the prescription changes from Pending to Ready.

If you wish to abort all changes, press the Cancel button. You can return to the prescription at a later time to update the information. The prescription status remains Pending.

Narcotic Prescriptions

Narcotic prescriptions are packaged at the end of the packaging run, after any PRN prescriptions. These prescriptions are packaged individually based on administration time and date.

To edit narcotic prescriptions, follow the applicable steps required for the type of administration time that is to be used: prescriptions with standard administration times, variable dosage prescriptions, or PRN prescriptions.

TIP If Narcotic prescriptions are not being sent to ADI, verify the group’s Auto-Dispensing Preferences. The narcotic must be selected in the Prescription Type box. Refer to pages 4-5 for details.
Resetting Default Packaging Options

If prescriptions have been sent to Pending with an incorrect Packaging Start Date, or default packaging options need to be modified, it is easy to reset the default packaging options for multiple prescriptions. When the packaging options are incorrect for a single prescription, they can easily be modified from the Process Group Rx window when verifying/editing the dosages. Use the following steps to reset multiple prescriptions.

1. Press or click the Pending icon in the Views menu located on the left side of the window.
2. To reset multiple selected prescriptions: Highlight each prescription that you want to process.
   - To highlight multiple prescriptions, hold down the CTRL key on the keyboard while highlighting.
   - To highlight a list of consecutive prescriptions, highlight the first prescription in the list, then hold down the SHIFT key on the keyboard while highlighting the last prescription in the list – all rows between the first and last prescriptions become highlighted.

   To review a group of prescriptions: Prescriptions can be grouped in a view – refer to the Grouping and Sorting Rows for details. To highlight all prescriptions in a group, click on the title bar for the group.

   To review all prescriptions in Pending: Press CTRL + A on the keyboard, OR press or click the Edit in the menu bar at the top of the window, then press or click the Select All. All prescriptions in Pending become highlighted.

3. Press or click the File in the menu bar at the top of the window.
4. Press or click the Reset Default Packaging Options.

   TIP  Save a step by pressing or clicking the button in the menu bar, instead of accessing File → Reset Default Packaging Options.

5. The Reset Default Packaging Options window appears. New default packaging options must be set for the selected prescription(s). Enter the Default Start Date. The remaining fields are optional – enter values in the Default End Date, the Default Start Time and/or the Default End Time if needed.

6. Press or click the OK button.
7. A prompt indicates the selected prescriptions have been reset. Press or click the OK button in the prompt.
8. The Process Group Rx window opens for each PENDING prescription that has been reset (it does not open for the READY prescriptions). Verify each prescription and then press or click the OK function button; the status of the prescription changes from Pending to Ready. The Process Group Rx window opens for the next Pending prescription. The screen returns to the Pending tab once all reset prescriptions have been reviewed.

   TIP  If you do not wish to verify each Pending prescription, press ALT + X on the keyboard to cancel out of the Process Group Rx window for all reset prescriptions.
Submitting Ready Transactions to the Device

Prescriptions with the status Ready must be submitted to the automated dispensing device for packaging. It is possible to preview the transactions before sending them to the device.

**To preview the transactions before sending them to the device**

1. Press or click the **Pending** icon in the **Views** menu located on the left side of the window.
2. Press or click the **File** in the menu bar at the top of the window.
3. Press or click the **Preview Send**.

**TIP** Save a step by pressing or clicking the icon in the menu bar, instead of accessing

**File → Preview Send.**

4. The **Preview Send** window opens, listing all READY prescriptions in the Pending view. Each row represents a single administration time.

5. **Optional:** Press or click the **Print** button to print a list of the transactions.
6. **Optional:** Press or click the **Send** button to send all READY transactions to the device. A prompt confirms if the prescriptions should be sent; press the **Yes** button to submit the prescription(s) to the device. A prompt indicates all prescriptions were sent successfully; press or click the **OK** in the prompt. The window closes and the screen returns to **Pending**.
7. Press or click the **Close** button to return to **Pending**.

**To submit Ready transactions without previewing**

1. Press or click the **Pending** icon in the **Views** menu located on the left side of the window.
2. To send a single prescription: Highlight the **Ready** prescription.
   - To highlight multiple prescriptions, hold down the CTRL key on the keyboard while highlighting.
   - To highlight a list of consecutive prescriptions, highlight the first prescription in the list, then hold down the SHIFT key on the keyboard while highlighting the last prescription in the list – all rows between the first and last prescriptions become highlighted.
   - **To send a group of prescriptions:** Prescriptions can be grouped in a view – refer to the
     **Grouping and Sorting Rows** for details. To highlight all prescriptions in a group, click on the title bar for the group.
   - **To send all prescriptions in Pending:** Press CTRL + A on the keyboard, or press the **Edit** in
     the menu bar at the top of the window, then press or click the **Select All**. All prescriptions in
     **Pending** become highlighted.
3. Press or click the **File** in the menu bar at the top of the window.
4. Press or click the **Send Ready Transactions to Device**.

**TIP** Save a step by pressing or click the icon in the menu bar, instead of accessing

**File → Reset Default Packaging Options.**

5. A prompt confirms if the prescriptions should be sent. Press or click the **Yes** button to submit the prescription(s) to the device.
Viewing Completed Transactions

Prescriptions send to the device move into the **Processed** view. The status of the prescriptions become **Sent**, indicating that they have been sent to the device. Once the device has successfully processed the prescriptions, the status changes to **Processed**.

To access the **Processed** view, press the Processed icon in the menu bar on the left side of the window.
6. Error Messages

The **Messages** view lists error and informational messages regarding prescriptions submitted to ADI. When a prescription is not found in **To Do**, **Pending** or **Processed**, check the **Messages** to see if an error occurred with the prescription.

To access the **Messages** view, press or click the **Messages** icon in the menu bar on the left side of the window.

**Viewing Messages**

1. Press or click the **Messages** icon in the Views menu located on the left side of the window. To view a single message: Highlight the message.

   **TIP** Save steps by double-clicking on the message. Skip to step 5 below.

   To view multiple selected messages: Highlight each message to be viewed.
   - To highlight multiple messages, hold down the CTRL key on the keyboard while highlighting.
   - To highlight a list of consecutive messages, highlight the first row in the list, then hold down the SHIFT key on the keyboard while highlighting the last row in the list – all rows between the first and last messages become highlighted.

   To view a group of messages: Messages can be grouped in a view – refer to the **Grouping and Sorting Rows** for details. To highlight all messages in a group, click on the title bar for the group.

   To view all messages: Press CTRL + A on the keyboard, OR press or click the **Edit** in the menu bar at the top of the window, then press or click the **Select All**. All messages become highlighted.

2. Press or click the **Edit** in the menu bar at the top of the window.

3. Press or click the **View Message(s)**.

   **TIP** Press the ENTER key or the **Messages** button in the menu bar instead of accessing **Edit** → **View**

4. The **Error Message** window opens, displaying the message text. Pressing or clicking the **Print** button prints the message.
5. Press or click the Close button. The next message appears if multiple messages were selected. The screen returns to the Message view once all selected messages have been displayed.

Deleting Messages

1. Press the Messages icon in the Views menu located on the left side of the window.
   
   To delete a single message: Highlight the message.
   
   To delete multiple selected messages: Highlight each message to be deleted.
   
   • To highlight multiple messages, hold down the CTRL key on the keyboard while highlighting.
   
   • To highlight a list of consecutive messages, highlight the first row in the list, then hold down the SHIFT key on the keyboard while highlighting the last row in the list – all rows between the first and last messages become highlighted.
   
   To delete a group of messages: Messages can be grouped in a view – refer to the Grouping and Sorting Rows for details. To highlight all messages in a group, click on the title bar for the group.
   
   To delete all messages: Press CTRL + A on the keyboard, OR press or click the Edit in the menu bar at the top of the window, then press or click the Select All. All messages become highlighted.
   
2. Press or click the Edit in the menu bar at the top of the window.

3. Press or click the Delete Message(s).

4. A prompt confirms if the message(s) should be deleted. Press the Yes button to delete the message(s).

Viewing Messages for all Workstations

The Messages view is workstation-specific, meaning you can view messages for prescriptions that were processed from the computer on which you are working. You can also view all messages, which are messages for prescriptions processed on all computers.

To view all messages

1. Press or click the Messages icon in the Views menu located on the left side of the window.

2. Press or click the View in the menu bar at the top of the window.

3. Press or click the Show All Messages. The messages view updates to show messages processed on all computers.

   Show All Messages appears when you are currently viewing messages processed from your workstation.

To view message for your workstation

1. Press the Messages icon in the Views menu located on the left side of the window

2. Press or click the View in the menu bar at the top of the window.

3. Press or click the Show Own Messages Only. The messages view updates to show messages for prescriptions processed on your computer.

   The Show Own Messages Only appears when you are currently viewing all messages.
7. Regenerating Prescriptions

Regenerate provides the ability to regenerate automated dispensing prescriptions using various criteria. This is useful for resubmitting prescriptions that had errors, or correcting batched Long-Term Care prescriptions.

Example. A batch is scheduled to run on Monday morning and all prescriptions are processed successfully. On Thursday, the long-term care facility calls the pharmacy to ask for changes to multiple patients. The selected prescriptions will be regenerated and repackaged using the new information.

To regenerate prescriptions

1. Press or click the Tools in the menu bar at the top of the window.
2. Press or click the Regenerate.
3. The Regenerate window opens. Enter search criteria for the prescriptions to be regenerated. The expand button located to the right of the Patient field opens the Patient Search, from where you can search for a specific patient.

4. Press or click the OK button.
5. Prescriptions meeting the search criteria are regenerated and the window closes. Some of the prescriptions appear in To Do, while others may appear in Pending with a status of Ready*. Select the prescriptions that need to be modified and process the changes as usual.
6. Delete any regenerated transactions in To Do and Pending that do not need to be processed.

Regenerating TIPS:

- The Start Date and the End Date cannot be used when the Rx# Range is specified. One or more prescription numbers can be specified. When regenerating multiple prescription numbers, enter a range of numbers using a dash (e.g. 500123-500129) to regenerate all prescriptions within the range, or separate each number with a comma to regenerate specific numbers (e.g. 500126,500134,500138).
- The Device dropdown list contains automated dispensing devices configured for your pharmacy.
- When regenerating for a retail device such as the Baker Cells, choose the Device and enter the Rx#.
- The Group dropdown list contains all groups entered in the PharmaClik Rx. A group must be selected when a value is entered in the Area, Floor, the Wing and/or the Cycle.
- Enter the Batch ID to regenerate an entire batch – no other criteria are required when regenerating a batch. To find the Batch ID in the PharmaClik Rx: go to the Workbench; highlight a prescription that is the batch, press or click the Rx button, press or click the Batch; the Batch ID is shown at the top of the Batch Profile.
8. Customizing Views in ADI

You can customize ADI on each workstation by changing column locations, adding text to the toolbar icons, and grouping and sorting rows in a view. Customization is specific to the workstation and the view.

Customizing Columns

Columns in a view can be resized and moved. This allows you to move unused and rarely used columns to the end of the grid, allowing the most important columns to be displayed in the view by default, without requiring you to scroll to the right. **Customized columns are retained when you exit ADI.**

**Resizing Columns**

1. Using the mouse, place the pointer over the rightmost side of the column header (e.g. to shorten the Date/Time field, place the arrow over the vertical line between the Date/Time and the Last Name).
2. The pointer turns into a double-sided arrow. Hold down the LEFT button on the mouse. A vertical line appears down the view.
3. Still holding down the LEFT mouse button, move the mouse to the right (to widen a column) or left (to shorten a column) until the vertical line is where you want the end of the column to be located.
4. Release the LEFT mouse button. The column width has now changed.

**Moving Columns**

1. Using the LEFT mouse button, press on the column header for the column you want to move.
2. Still holding down the LEFT mouse button, move the mouse to the right (to move the column towards the end of the grid) or left (to move the column towards the beginning of the grid) until red arrows appear in the location where you want to relocate the column.
3. Release of the LEFT mouse button. The column is now in its new location.
Resetting Column Defaults

Once column locations and widths are customized in a view, the customization is permanently retained on that Workstation. The following steps explain how to return a view to its default column locations and widths. When column defaults are reset, the reset applies to the view currently displayed on the screen and does not apply to all views.

To reset columns in a view
1. Go to the view that needs to be reset (To Do, Pending, Processed, Messages).
2. Press or click the View in the menu bar at the top of the window.
3. Press or click the Reset Column Defaults.

Grouping and Sorting Rows

Sorting and grouping functions are available in each view. Grouping provides the ability to group rows together, while the sorting allows the rows to be sorted in a specific order.

Grouping and sorting settings are reset when you exit ADI.

Sorting

The rows in each view can be sorted based on any column in the window. Click on the column header and a small arrow appears. When the arrow is pointed down, the rows are sorted in descending order based on the values in the selected column. When the arrow is pointed upwards, the rows are sorted in ascending order.

The rows are sorted in alphabetical order based on the Last Name.
Grouping

Rows can be grouped according to any columns in the window. The diagrams shown below explain how to group rows. The first step is to select the criteria by which the rows should be sorted. In the example shown here, we want to view the rows based on patient name. All prescriptions for each patient will be shown together, with the number of prescriptions in each grouping indicated in brackets.

1. Using the LEFT button on the mouse, click on the heading of the Last Name column and hold the button down.
2. Still holding down the LEFT mouse button, drag the mouse to the area that says, Drag a column header here to group by that column. Red arrows appear to indicate where you want to drop the column.
3. Release the LEFT mouse button to drop the heading.

The rows on the screen are now grouped by patient last name. The number of prescriptions in each grouping is shown in brackets on the grouping bar.

It is possible to hide the rows in a group by pressing the minus button located left to the name of the group. Once the values are hidden, the icon becomes a + icon. Pressing or clicking the + icon displays the rows again.

TIP Clicking on the grouping bar highlights all rows within that group.

It is also possible to add subgroups within each grouping. For example, in the Pending view, you may want to sort by the patient’s Last Name and then by Status within each patient. In this case the Last Name would be the primary grouping and the Status would be the subgroup. To add a subgroup, follow the same steps as described above; select the column header, drag it to the grouping area and drop it to the right of the primary grouping.

To remove a grouping

1. Use the mouse to select the name of the grouping and drag it back to the body the grid.
2. Drop it anywhere on the grid. The grouping is removed.
Filtering Views

A Filter option allows you to find specific information in the various views (e.g. filter on a patient’s last name in the Pending view to only see prescriptions for that patient). The filter is specific to the view and will be retained until it is removed. **Filtering is removed when your exit ADI.**

**To set a filter**

1. You must be in the view that is to be filtered.
2. Press or click the `button in the toolbar at the top of the window or CTRL + F on the keyboard.
3. The **Filter** window opens. Enter the text to be filtered.
4. Press or click the **OK** function button. The view is updated to only display rows containing the filtered text. The number of filtered prescriptions and the filter criteria are shown at the top of the view.

![Filtering: Campbell](Image)

**To remove a filter**

1. Press or click the `button in the toolbar or CTRL + F on the keyboard.
2. The **Filter** window opens. Press or click the **Delete** key on the keyboard to clear the filter.
3. Press or click the **OK** button.

Displaying Text on the Toolbar

By default, the toolbar at the top of the window does not contain any descriptions, as shown below. When the cursor is placed over the toolbar buttons, a tooltip indicates the name of the button.

![Toolbar Buttons](Image)

For easier navigation, it is possible to permanently display button names on the toolbar.

**To show toolbar text**

1. Press or click the **View** in the menu bar at the top of the window.
2. Press or click the **Show Toolbar Text**. The toolbar resizes and shows the name of each button below the picture.

![Show Toolbar Text](Image)

**To hide toolbar text**

1. Press or click the **View** in the menu bar at the top of the window.
2. Press or click the **Hide Toolbar Text**. The toolbar resizes and removes the button names.
9. Tools: Configuring ADI

ADI can be configured through the **Tools** menu, which is accessed by pressing the **Tools** option in the menu bar located across the top of the window.

### Options

The Options window contains the **Application** options and the **Baker Cells** options.

#### Application Options
- General
- Confirmation
- Monitor

#### Baker Cells Options
- Cells
- General

To view the various options, press the appropriate icon in the menu on the left side of the window. The options for your selection are shown on the screen. For all selections, pressing or clicking the **OK** button saves changes and closes the window. Pressing or clicking the **Cancel** button aborts changes and closes the window.

### General Options

Press or click the **General** icon in the **Application** bar to view the **General** options. The default settings are shown in the screenshot below.

- **Beep on Error**: When selected, ADI beeps when an error occurs.
- **Minimize Application on Startup**: Once ADI is activated, it automatically minimizes itself to the Task Bar.
- **Number of days to retain processed Rx**: The number of days packaged transactions will be stored in the Processed view. This is 30 days by default; processed transactions are automatically deleted 30 days after packaging, with the exception of the original packaged prescription, which is retained permanently.
- **Include doctor name in output**: The doctor's name will be included in the output file sent to the device. This setting is defaulted ON. This allows the doctor to print for each prescription listed on the pouch, provided your device is configured to allow space for the doctor's name.
- **Process Retail Rx**: Applies when the device is down or the interface is stopped and then restarted. This allows the queued transactions to be submitted for packaging.
Confirmation Options

Press or click the **Confirmation** icon in the **Application** bar to view the **Confirmation** options. The default settings are shown in the screenshot below.

- **Confirm Exit from the Application**: When you attempt to close the ADI, a message asks if you want to exit.
- **Confirm Cancellation of Editing**: When you press the **Cancel** function button in the Process Group Rx window, a message asks if you want to cancel editing all of the selected prescriptions.
- **Confirm Deletion of Transactions**: When you attempt to delete one or more transactions, a message asks if you really want to delete the selected transaction(s).
- **Confirm Start Processing**: You can temporarily stop automated dispensing from PharmaClik Rx by selecting the **Stop Processing** from the **Tools** → **Support** menu. To restart processing, you can select the **Start Processing** from the **Tools** → **Support** menu. When the **Confirm Start Processing** is **ON**, a message asks if you really want to begin processing.
- **Confirm Stop Processing**: You can temporarily stop automated dispensing from the PharmaClick Rx by selecting the **Stop Processing** from the **Tools** → **Support** menu. When the **Confirm Stop Processing** is **ON**, a message asks if you really want to stop processing.

Monitor Options

Press or click the **Monitor** in the **Application** bar to view the **Monitor** options. The default settings are shown in the screenshot below.

- **Number of Processed Transactions to Display**: This value is set to 200 and should not be increased, unless advised to do so by the PharmaClik Rx Support for purposes of troubleshooting.
- **Number of Messages to Display**: The maximum number of rows to display in the **Messages** view. This value is set to 200 and should not be increased, unless advised to do so by the PharmaClik Rx Support for purposes of troubleshooting.
- **Polling seconds for data update checking**: ADI is updated from PharmaClik Rx every so many seconds. By default, ADI checks the PharmaClik Rx every 3 seconds for new data.
- **Automatic grid refreshing interval**: Focus is retained in ADI views, meaning if you open the **Group Rx** window from the **Pending** view, you will still be on the same row when you close the window and return to **Pending**. The view is not refreshed during this time. The **Automatic grid refreshing interval** refreshes the grid every so many minutes to reflect with data updated on other workstations.
Baker Cells Options

The Baker Cells options apply to the Baker automated dispensing devices. To access the Baker Cells options, press or click the Baker Cells bar in the menu on the left side of the Options window. The Cells and General options are available.

Cells

Press or click the Cells in the Baker Cells menu to view a listing of current cells and to add/remove cells. Cells display a grid containing a DIN mapping for the Baker Cells. This mapping tells the ADI which DIN is contained in which cell. This screen must be configured BEFORE the Baker Cells devices can be used; if cells are not mapped to a specific DIN, the medication will not be auto-dispensed.

To add a new cell

1. Press or click the Tools in the menu bar at the top of the window.
2. Press or click the Options.
3. Press or click the Baker Cells bar in the Options window.
4. The Cells options are displayed. Press or click the Add Cell button.
5. The Add Cell window opens. Enter the cell number in the Cell field.
6. Enter the DIN in the DIN field.
7. Press or click the OK button to accept the new cell.

If the new cell already exists, an error message indicates the cell is a duplicate. The cell number must be changed before the mapping can be accepted. An error message also appears if the DIN is already mapped to a different cell.

To add multiple new cells (bulk add)

The Bulk Add function provides the ability to add multiple cells at once. For each cell, the DIN defaults to zero. The zero must be changed to a valid DIN before product can be dispensed from the cell.

1. Press or click the Tools in the menu bar at the top of the window.
2. Press or click the Options.
3. Press or click the Baker Cells bar in the Options window.
4. The Cells options are displayed. Press or click the Bulk Add button.
5. The Cell Bulk Add window options. Enter the Starting cell number and the Ending cell number (e.g. if 10 is the starting number and 20 is the ending number, 11 rows will be added to the mapping, with the cells numbered 10 through to 20).
6. The new rows are added to the Cells grid.
7. Enter the Cell number and corresponding DIN for each row.
8. Press or click the OK button to accept the new cells.
To modify a cell

1. Press or click the **Tools** in the menu bar at the top of the window.
2. Press or click the **Options**.
3. Press or click the **Baker Cells** bar in the **Options** window.
4. The **Cells** options are displayed. Find the Cell number to be edited.
5. Modify the **DIN** field as required.
6. Repeat steps 4-5 if you need to modify another cell.
7. Press or click the **OK** button to save changes.

To delete a cell

1. Press or click the **Tools** in the menu bar at the top of the window.
2. Press or click the **Options**.
3. Press or click the **Baker Cells** bar in the **Options** window.
4. The **Cells** options are displayed. Highlight the cell number to be deleted.
5. Press or click the **Delete Cell** button.

**TIP** There is NO prompt to confirm whether or not the cell should be deleted. If you have made an error and deleted an incorrect cell, you can press or click the Cancel button. Pressing or clicking the Cancel aborts ALL of your changes and closes the Options window.

6. Press or click the **OK** button to save changes.

**General**

Press or click the **General** icon in the **Baker Cells** menu to view general options for the **Baker Cells**. The default settings are shown in the screenshot below.

- **Auto-dispense Nursing Home Prescriptions:** When selected, non-retail prescriptions can be dispensed from the **Baker Cells** device.

**Support Tools**

The Support menu should ONLY be used under the direction of the PharmaClik Rx Support representative.

**DO NOT USE THIS OPTION UNLESS DIRECTED TO DO SO BY PharmaClik Rx SUPPORT**
10. Configured Devices

The **Devices** view displays the automated dispensing devices configured for your pharmacy. The list of devices cannot be edited; only the PharmaClik Rx Support representatives can make changes to the devices.

To access the **Devices** view, press the **Devices** icon in the menu bar on the left side of the window.

### Stopping Interfaces

**Do not use this option unless directed to do so by the PharmaClik Rx Support**

It is possible to stop the **Baker Cells** and **Parata RDS** interfaces. Although the interfaces are stopped, the transactions will still queue up, similar to when an interface is disabled. The interfaces can be stopped and re-started by right-clicking on the name of the device in the **Devices** view and choosing the **Stop Interface** or **Start Interface**.

### Testing the Baker Cells Configuration

To check if a cell is correctly configured before filling any prescriptions, use the **Test Baker Cells** option. The **Baker Cells Test** window allows you to specify the cell you wish to test, along with the quantity of medication that you would like to dispense in the test.

**To test Baker Cells**

1. Press or click the **Device** icon in the **Views** menu located on the left side of the window.
2. In the **Device** view, right-click on the **Baker Cell** row.
3. Select the **Test Baker Cells** in the menu that appears.
4. The **Baker Cell Test** window appears. Enter the cell number in the **Cell** field.
5. Enter the amount of medication in the **Quantity** field.
6. Press or click the **OK** button to send the test to the **Baker Cells** device.
Testing Para Data RDS Configuration

To check if the Parata is correctly configured before filling any prescriptions, use the Test Parata Interface option.

### To test Parata RDS
1. Press or click the Device icon in the Views menu located on the left side of the window.
2. In the Device view, right-click on the Parata row.
3. Select the Test Parata Interface in the menu that appears.
4. The Parata Interface Test window appears.
5. Choose the Transaction Type to be tested.
6. Enter a prescription number that was submitted to Parata.
7. Press or click the Retrieve button.
8. Choose the Parata from the dropdown list in the middle of the window.
9. Press or click the Send button.
10. Repeat steps 5-9 for other transaction types and/or prescriptions.
11. Press or click the Close button when you are finished.

![Parata Interface Test Window](image)
Q1. Are changes sent to ADI when a prescription is rebilled or amended?
Yes. When a prescription is rebilled or amended (using Amend or Amend LTC) in the PharmaClik Rx, the updated information is sent to ADI if one or more of the following fields are modified:

- Drug/DIN (Located in the main tab of Rx Detail – applicable for Rebill)
- Qty (Located in the main tab of Rx Detail – applicable for Rebill)
- SIG (Located in the main tab of Rx Detail)
- Admin Times (Located in the main tab of Rx Detail)
- Time and Qty (Located in Rx Detail Administration Details)
- Administration Days (Located in Rx Detail Administration Details)
- Allow Auto-Dispensing (Located in Rx Detail Administration Details)
- Stop Date (Located in Rx Detail Administration Details)

When a prescription is amended/rebilled and the transaction still exists in the ADI, the Date/Time column in ADI is updated to reflect the new transaction and one the following occurs, depending on the prescription’s current status in ADI.

- **To Do View:** The transaction is replaced with the new information. The status remains as To Do.
- **Pending View with a Pending Status:** The transaction is replaced with the new information. The status remains as Pending.
- **Pending View with a Ready Status:** The transaction is NOT updated with the new information. The status changes to Ready?, meaning the prescription has been updated in the PharmaClik Rx and needs to be reviewed in ADI before processing can continue. When the Ready? Transaction opens, **RX MODIFIED IN PharmaClik Rx** flashes in red and the Refresh button is enabled. Press or click the Refresh button to update prescription. Review the prescription as usual, then press or click the OK button to save changes. The transaction status changes to Ready and can be processed.
Q2. **When a prescription is cancelled, is it removed from ADI?**
Yes. If a transaction is in the **To Do** or the **Pending** view and the corresponding prescription is cancelled in the PharmaClik Rx, the prescription is also removed from ADI.

Q3. **What does Ready* mean?**
Once ADI processes a non-retail prescription, the data for the prescription is recorded for future refills. When a prescription is refilled, and the prescription quantity and administration times are the same as the previous fill, the refill is automatically placed in **Pending** with a status of **Ready***. The * symbol beside the word *Ready* indicates that the administration times and quantities are the same as the previously packaged fill. The **Ready*** prescriptions do not need to be edited.

Q4. **Is there a way to print a list of prescriptions in an ADI view?**
Yes, it is possible to obtain a printed list of information in the view. The list prints to the computer’s default printer. If the default printer is the dispensary label printer, ensure pain paper is in the Label tray before printing.

**To print items in a view**
1. Press or click the **View** in the menu bar across the top of the window.
2. Press or click the **Print**.

Q5. **Can a list of ADI prescriptions be saved?**
In any of the ADI views, it is possible to save the items listed in the window. The items will be saved to a text file which can be retrieved whenever necessary.

**To save items to file**
1. Press or click the **View** in the menu bar across the top of the window.
2. Press or click the **Save to File**.
3. The **Save As** window appears. A name for the file is defaulted in the **File name** field; the file name can be changed if you so wish. Select the location where the file should be saved (the default file location is the **My Documents** folder).
4. Press or click the **Save** button to save the file.

Q6. **Prescriptions are missing from ADI. What should I do?**
When transactions are not appearing in ADI, try the following:

- Refresh the application by pressing the **F5** key on the keyboard or by selecting **View** → **Refresh** from the menu bar at the top of the window.
- Regenerate the prescriptions.
- Check the **Messages** view to see if there was a problem with the prescriptions. Correct the problem, and then regenerate the prescription.
- Verify the prescriptions in the PharmaClik Rx to see if it was in fact submitted to an automated dispensing device.
- If the transactions are PRN or Narcotic prescriptions, check the **Group Auto-Dispensing Preferences** in the PharmaClik Rx to see if PRNs and Narcotics are flagged for auto-dispensed.
- Check the **Rx Detail** or the patient’s **Profile** to see if the prescription is flagged as Dosett or Dispill. Dosett and Dispill prescriptions do not get packaged.
- If the transactions are still not appearing, exit ADI and then restart the program.

Q7. **Why do some administration times incorrectly appear as 00:00 in the Process Group Rx window?**
Administration times that do not use a colon (e.g. 0800) appear in the **Process Group Rx** window as 00:00. When you know that time is incorrect, verify and correct the administration time that was used in the PharmaClik Rx, ensuring the correct administration time is used on future fills.
Q8. **When happens if a prescription has an alpha administration time?**

With the exception of PRN prescriptions, non-retail prescriptions with alpha administration times such as HS are invalid. The prescription will be sent to ADI and appear in the **ToDo** view, but cannot be sent to **Pending**. An error similar to the following appears in the **Messages** view.

![Error Message]

To correct the prescription, amend the administration times in the **Rx Detail**. Since ADI does not support non-numeric administration times, a set time should be used for prescriptions that have a text administration time such as HS (e.g. in place of HS, use the standard bedtime for the facility; if the bedtime dose is generally administered at 21:00, then use 21:00 as the administration time in the prescription).

The corrected administration times are sent to ADI as soon as the prescription is amended in the PharmaClik Rx. You can now send them **ToDo** transaction to **Pending** and continue packaging as usual.

Q9. **Can the SIG print on the pouches?**

Yes. Translated instructions are included in the output file, allowing instructions to print on non-retail pouches/bags. Please contact your device provider to confirm if your device supports instructions – your device’s settings may have to be configured to print the instructions.

Q10. **Can the doctor’s name print on the pouches?**

Yes. This is a configuration option in ADI, which is turned **ON** by default.

**To turn on/off printing the doctor’s name on pouches**

1. Press or click the **Tools** in the menu bar across the top of the window.
2. Press or click the **Options**.
3. The **General** options window opens.
   - **To print the doctor’s name**: Turn **ON** the **Include doctor name in output** checkbox.
   - **To omit the doctor’s name**: Turn **OFF** the **Include doctor name in output** checkbox.
4. Press or click the **OK** button to save.

Q11. **Can Dispill or Dosett prescriptions be auto-dispensed?**

No. Dispill and Dosett prescriptions are not auto-dispensed, as they are already provided to patients in a compliance package: either a Dispill card, blister/bubble card, or a dosett.